NI 9205/9206 Calibration
Procedure

This document contains information about calibrating National
Instruments 9205/9206 modules using NI-DAQmx. This calibration
procedure is intended for metrology labs.

This document does not discuss programming techniques or compiler
configuration. The NI-DAQmx driver contains online help files that have
compiler-specific instructions and detailed function explanations. You can
install these help files when you install NI-DAQmx on the calibration
computer.

The NI 9205 and NI 9206 should be calibrated at a regular interval as
defined by the measurement accuracy requirements of your application.
National Instruments recommends that you routinely perform a complete
calibration at least once every two years. You can shorten this interval based
on the accuracy demands of your application or requirements of your
processes. Self-calibration can be performed as needed or when the
temperature varies by 5 °C or more from the last external calibration.
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NI 9205/9206

The following conventions appear in this manual:

The » symbol leads you through nested menu items and dialog box options
to a final action. The sequence File»Page Setup»Options directs you to
pull down the File menu, select the Page Setup item, and select Options
from the last dialog box.

This icon denotes a note, which alerts you to important information.

Bold text denotes items that you must select or click in the software, such
as menu items and dialog box options. Bold text also denotes parameter
names and hardware labels.

Italic text denotes variables, emphasis, a cross-reference, or an introduction
to a key concept. Italic text also denotes text that is a placeholder for a word
or value that you must supply.

Monospace text denotes text or characters that you should enter from the
keyboard, sections of code, programming examples, and syntax examples.
This font is also used for the proper names of disk drives, paths, directories,
programs, subprograms, subroutines, device names, functions, operations,
variables, filenames, and extensions.

NI 9205/9206 refers to the NI 9205 and NI 9206.
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Calibration Options

The NI 9205/9206 support two types of calibration: self-calibration and
external calibration.

Self-Calibration

Self-calibration, also known as internal calibration, uses a software
command and requires no external connections. Self-calibration improves
measurement accuracy by compensating for variables such as temperature
that might have changed since the last external calibration. Self-calibration
retains the traceability of the external calibration and can be performed as
necessary to compensate for environmental changes.

External Calibration

External calibration is generally performed with a high-precision calibrator
at either NI or a metrology lab. This procedure replaces all calibration
constants in the EEPROM and is equivalent to a factory calibration at NI.
Because the external calibration procedure changes all EEPROM
constants, it invalidates the original calibration certificate. If an external
calibration is done with a traceable signal generator source, a new
calibration certificate can be issued. This document describes specific
programming steps for writing an external calibration procedure for the
NI 9205/9206.

Software and Documentation Requirements

This section describes the software and documentation required for both
self-calibration and external calibration.

Software

Install NI-DAQmx 8.1 or later on the calibration computer. NI-DAQmx
includes high-level function calls to simplify the task of writing software to
calibrate devices. You must have the proper device driver installed on the
calibration system before calibrating the device.

@ Note NI recommends that you install the NI-DAQmx driver software before physically
installing the NI 9205/9206. NI-DAQmx, available at ni . com/downloads, configures
and controls the NI 9205/9206.

NI-DAQmzx supports a number of programming languages, including
LabVIEW, LabWindows™/CVI™, Microsoft Visual C++ 6.0, Microsoft
Visual Basic 6.0, Microsoft .NET, and Borland C++.
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You can access the NI-DAQmx header file, NIDAQmx . h, like any standard
library. You can find examples of how to use the NI-DAQmx driver in the
Program Files\National Instruments\NI-DAQ\Examples
directory.

Documentation

You might find the following documentation helpful as you write the
calibration procedure:

e NI-DAQmx Help—This help file contains general information about
measurement concepts, key NI-DAQmx concepts, and common
applications that apply to all programming environments. To access
this help file, select Start»All Programs»National Instruments»
NI-DAQ»NI-DAQmx Help.

*  NI-DAQmx C Reference Help—This help file contains C reference and
general information about measurement concepts. To access this help
file, select Start»All Programs»National Instruments»NI-DAQ»
NI-DAQmx C Reference Help.

*  DAQ Getting Started Guide for NI-DAQ 8.0 or later—This guide
describes how to install NI-DAQmx for Windows software and
NI-DAQmx-supported DAQ devices, and how to confirm that your
device is operating properly. To access this guide, select Start»
All Programs»National Instruments»NI-DAQ»DAQ Getting
Started Guide.

Note The documents above are installed with NI-DAQmx. You can also download the
latest versions from the NI Web site at ni . com/manuals.

e NI 9205 Operating Instructions/NI 9206 Operating Instructions—
These documents contain information about specific device features.
The limits you use to verify the accuracy of the devices are based on
the specifications found in this document. You can download the latest
versions of these documents from the NI Web site at ni . com/
manuals.
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Calibration Requirements

Password

The default password for password-protected operations is NI.

Test Equipment

National Instruments recommends that you use the following equipment
for calibrating the NI 9205/9206:

Test Conditions

Fluke 5700A calibrator. If that instrument is unavailable, use a
high-precision voltage source with an accuracy of at least 10 ppm.

NI cDAQ-9172 chassis.

Follow these guidelines to optimize the connections and the environment:

Keep connections to the device as short as possible. Long cables and
wires act as antennae, picking up extra noise that can affect
measurements.

Use shielded copper wire for all cable connections to the device.
Use twisted-pair wire to eliminate noise and thermal offsets.

Maintain an ambient temperature of 23 10 °C. The device
temperature will be greater than the ambient temperature.

Keep relative humidity below 80%.

Allow a warm-up time of at least 10 minutes to ensure that the
measurement circuitry is at a stable operating temperature.

Calibration Process

This section provides instructions for verifying and adjusting the
NI 9205/9206.

Calibration Process Overview

The calibration process consists of the following steps:

1.
2.

© National Instruments Corporation

Initial Setup—Configure the device in NI-DAQmx.

Self-Calibration—Measure the onboard reference voltage of the
device and adjust the self-calibration constants.

Verification Procedure—Verify the existing operation of the device.
This step confirms whether the device was operating within its
specified range prior to calibration.
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4. Adjustment Procedure—Perform an external calibration that adjusts
the device calibration constants with respect to a known voltage
source.

5. Perform another verification to ensure that the device operates within
its specifications after adjustment.

The first four steps are explained in the following sections.

Initial Setup

You must configure the device in Measurement & Automation Explorer
(MAX) to communicate with NI-DAQmx.

Complete the following steps to configure a device in MAX:
1. Install the NI-DAQmx driver software.

2. Make sure that no power is connected to the module terminals. If the
system is in a nonhazardous location, the chassis power can be on
when you install the module.

Insert the module into an available slot in the cDAQ-9172 chassis.
4. Launch MAX.

Right-click the device name and select Self-Test to ensure that the
device is working properly.

@ Note When a device is configured with MAX, it is assigned a device name. Each function
call uses this device name to determine which DAQ device to calibrate. This document uses
devl to refer to the device name. In the following procedures, use the device name as it
appears in MAX.

Self-Calibration

Self-calibrate the device before completing the first verification, after the
device has warmed up for the recommended time period. DAQmxSelfCal
(DAQmx Self Calibrate VI), as shown in the following table, measures the
onboard reference voltage of the device and adjusts the self-calibration
constants to account for any errors caused by short-term fluctuations in the
operating environment. When you self-calibrate a device, no external
signal connections are necessary.

NI-DAQmzx Function Call LabVIEW Block Diagram

Call DAQmxSelfCal with the
following parameters:

: ;. error ouk
deviceName: devl -
ST (] QS T W SeS =

(S e
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Verification Procedure

Verification determines how well the device is meeting its specifications.
By completing this procedure, you can see how the device has drifted over
time, which helps you determine the appropriate calibration interval for
your application. Table 4 in the Device Test Limits section shows all
acceptable settings for the device type. Throughout the verification process,
use Table 4 to determine if the device is operating within its specified range
prior to calibration. Because the NI 9205/9206 has many different ranges,
you must verify measurements for each available range on these modules.

Complete the following steps to test the performance of the device:

1. Refer to Table 1 for a list of the NI connection accessories for the
NI 9205/9206 and instructions on connecting the calibrator to the

device.

Table 1. NI Connection Accessories

Device Connection Accessory Connection Instructions
NI9205/9206 | NI 9940 36-position strain Connect the positive output of the calibrator to
relief & high voltage connector | AIO (pin 1) and the negative output of the
kit calibrator to AI8 (pin 19) and COM (pin 17). If
the calibrator has a guard connection, connect
that terminal to COM instead of connecting
COM to the negative output.
NI 9205 with | NI 9933 37-pin connector kit, Connect the positive output of the calibrator to
DSUB screw terminal connector and AIO (pin 1) and the negative output of the
DSUB shell calibrator to AI8 (pin 20) and COM (pin 10). If
the calibrator has a guard connection, connect
that terminal to COM instead of connecting
COM to the negative output.

2. Set the calibrator voltage to the Test Point value indicated in Table 4.
NI recommends that you verify all values, although you can save time
by verifying only the values used in your application.

3. Ifyouuse C function calls, create a task using DAQmxCreateTask, as
shown in the following table. If you use LabVIEW, skip this step. The
task is created in step 4 in LabVIEW.

NI-DAQmx Function Call

LabVIEW Block Diagram

Call DAQmxCreateTask with the
following parameters:

taskName: AIVerificationTask
taskHandle: staskHandle

LabVIEW does not require this step.
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4. Create and configure an Al voltage channel through NI-DAQmzx using
DAQmxCreateAIVoltageChan (DAQmx Create Virtual Channel
VI), as shown in the following table. Use Table 4 to determine the
minimum and maximum values for the device.

NI-DAQmx Function Call

LabVIEW Block Diagram

Call DAQmxCreateAIVoltageChan
with the following parameters:

taskHandle: taskHandle
physicalChannel: dev1/ai0
nameToAssignToChannel:
myVoltageChannel
terminal Config:
DAQmx_Val_Cfg_Default
minVal: -10.0

maxVval: 10.0

units: DAQmx_Val_Volts
customScaleName: NULL

Dif ferential =

5. Configure the timing properties for the voltage acquisition using
DAQmxC fgSampClkTiming (DAQmx Timing VI), as shown in the
following table.

NI-DAQmx Function Call

LabVIEW Block Diagram

Call DAQmxCfgSampClkTiming
with the following parameters:

taskHandle: taskHandle
source: NULL
rate: 100000.0

activeEdge: Fask out
DAQmx_Val_Rising /0
sampleMode:
DAQmx_Val_FiniteSamps ¥ LK
sampsPerChan: 10000 |Sampie Clock ~ ] bEat
[S=ck
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6. Start the acquisition using DAQmxStartTask (DAQmx Start Task VI),
as shown in the following table.

NI-DAQmx Function Call

LabVIEW Block Diagram

Call DAQmxStartTask with
the following parameter:

taskHandle: taskHandle

—

]

[Es:h

kask ouk

askjchannels in

(]
Ll
,_J““‘"E

7. Acquire 10,000 points of voltage data using DAQmxReadAnalogF64
(DAQmx Read VI), as shown in the following table.

sampsPerChanRead: &read
reserved: NULL

NI-DAQmx Function Call LabVIEW Block Diagram

Call bAQOmxReadAnalogF64 with the
following parameters:
taskHandle: taskHandle askjchannels in ask out
numSampsPerChan: -1 Lo s
timeout: 10.0

. kimeout data
fillMode: 1 DR | b
DAQmx_Val_GroupByChannel ﬁ%
readArray: data —— Analog 10 DBL rror out
arraySizeInSamples: 10000 5ot B | 1Chan MSamp |

8. Average the voltage values that you acquired. Compare the resulting
average to the Upper Limit and Lower Limit values in Table 4. If the
result is between these values, the device passes the test.

9. Clear the acquisition using DAQmxClearTask (DAQmx Clear Task
VI), as shown in the following table.

NI-DAQmx Function Call

LabVIEW Block Diagram

Call DAQmxClearTask with the following

parameter:

taskHandle: taskHandle

o]
L

s b P o

10. Repeat steps 3 through 9 for all ranges and all values.

11. Disconnect the calibrator from the device or proceed to the Adjustment
Procedure section to adjust the analog input calibration constants.

© National Instruments Corporation
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Adjustment Procedure

The NI 9205/9206 adjustment procedure adjusts the analog input
calibration constants. At the end of each adjustment procedure, the new
constants are stored in the external calibration area of the device EEPROM.
These values are password-protected, which ensures that you do not
accidentally access or modify any calibration constants adjusted by the
metrology laboratory. The default password is NT.

Complete the following steps to adjust the device with a calibrator:

1. Refer to Table 1 for a list of the NI connection accessories for the
NI 9205/9206 and instructions on connecting the calibrator to the
device.

2. Set the calibrator to output 4.0 V.

Open a calibration session on the device using DAQmxInitExtCal
(DAQmx Initialize External Calibration VI), as shown in the following
table.

NI-DAQmx Function Call LabVIEW Block Diagram

Call DAQmxInitExtCal
with the following

parameters: ralhandle out

deviceName: devl
password: NT
calHandle: scalHandle
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4.

Perform an external adjustment using DAQmxMSeriesCalAdjust
(DAQmx Adjust M-Series Calibration VI), as shown in the following
table.

NI-DAQmx Function Call

LabVIEW Block Diagram

Call
DAQmxMSeriesCalAdjust
with the following
parameters:

calHandle: calHandle
referenceVoltage: 4.0

alhandle in
(=T

calhandle ouk

Feference volkage (4.0 V)]
b

"""
S bt

5

EEPROM.

Save the adjustment to the EEPROM using DAQmxCloseExtCal
(DAQmx Close External Calibration), as shown in the following table.
This function also saves the date, time, and temperature of the
adjustment to the onboard memory.

Note If the device fails the calibration procedure, no constants are written to the

NI-DAQmx Function Call LabVIEW Block Diagram
Call DAQOmxCloseExtCal -

with the following ahandle in

parameters: U |

calHandle: calHandle ko

action: DAQmx_val_ =T
Action_Commit Foan

P o W

6.

Disconnect the calibrator from the device.

The device is now calibrated with respect to the external source. After
calibrating the device, verify the analog input operation by repeating the
Verification Procedure section.

© National Instruments Corporation
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Al Absolute Accuracy Tables and Formulas

The values in the following tables are based on calibrated scaling
coefficients, which are stored in the onboard EEPROM. The following
calibration specifications are for 23 £10 °C.

Table 2. Accuracy Summary

Absolute Accuracy Random Noise,
Nominal Range (V) at Full Scale! (uV) 6 (WVrms) Sensitivity? (LV)
+10 3230 240 96.0
+5 1730 116 46.4
+] 390 26 10.4
+0.2 114 10 4.0

! Absolute accuracy values at full scale on the analog input channels assume the device is operating within 10 °C of the last
external calibration and are valid for averaging 100 samples immediately following internal calibration.

2 Sensitivity is the smallest voltage change that can be detected. It is a function of noise.

Table 3. Accuracy Details

Residual Residual
Gain Offset Offset
Error Gain Error Tempco INLError
Nominal (ppm of Tempco | Reference | (ppm of (ppm of (ppm of
Range (V) | Reading) (ppm/°C) Tempco Range) Range/°C) Range)
+10 115 11 5 20 44 76
+5 135 11 5 20 47 76
+1 155 11 5 25 66 76
+0.2 215 11 5 40 162 76
NI 9205/9206 Calibration Procedure 12 ni.com



AbsoluteAccuracy = Reading - (GainError) + Range - (OffsetError) + NoiseUncertainty

GainError = Residual AlGainError + GainTempco - (TempChangeFromLastInternalCal) +
ReferenceTempco - (TempChangeFromLastExternalCal)

OffsetError = Residual AIOffsetError + OffsetTempco - (TempChangeFromLastInternalCal) +
INL_Error

Noise Uncertainty = RandomNoise - 3 / /10000 for a coverage factor of 3 X and averaging
10000 points

Residual AlGainError = ErrorRelativetoExternalRef,,,,, + ReferenceDriftOverTime,m per year -
JCalibrationIntewal

years

GainTempco = AnalogCircuitryGainTempco

ReferenceTempco = ReferenceDriftOverTime,p,

ResidualOffsetError = OffsetErrorDueToCalibration,,p,

OffsetTempco = PreGainOffsetTempco,y / Rangey + PostGainOffsetTempco

INL_Error =2 - ADC_Dithered_INL

RandomNoise = RandomNoise, yyms

Device Test Limits

Table 4 lists the specifications that the NI 9205/9206 meets if it has been
two years between calibrations.

Using the Table

The following definitions describe how to use the information from
Table 4.

Range

Range refers to the minimum or maximum voltage range of an input signal.
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Test Point

The Test Point is the voltage value that is input or output for verification
purposes. This value is broken down into two columns—Location and
Value. Location refers to where the test value fits within the test range.
Value refers to the voltage value to be verified. Max refers to maximum
value, Min refers to minimum value, and Mid refers to mid-scale.

2-Year Limits

The 2-Year Limits column contains the Upper Limits and Lower Limits for
the test point value. That is, when the device is within its 2-year calibration
interval, the test point value should fall between these upper and lower limit
values.

Table 4. NI 9205/9206 Analog Input Values

Range (V) Test Point 2-Year Limits
Minimum | Maximum Location Value (V) | Lower Limit (V) | Upper Limit (V)
-10 10 Max 9.980000 9.976836 9.983164
-10 10 Mid 0.000000 -0.001407 0.001407
-10 10 Min -9.980000 -9.983164 -9.976836
-5 5 Max 4.990000 4.988303 4.991697
=5 5 Mid 0.000000 -0.000718 0.000718
-5 5 Min —-4.990000 —4.991697 —4.988303
-1 1 Max 0.998000 0.997617 0.998383
-1 1 Mid 0.000000 -0.000168 0.000168
-1 1 Min -0.998000 -0.998383 -0.997617
-0.200 0.200 Max 0.199600 0.199489 0.199711
-0.200 0.200 Mid 0.000000 -0.000056 0.000056
-0.200 0.200 Min —0.199600 -0.199711 —0.199489
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Where to Go for Support

The National Instruments Web site is your complete resource for technical
support. At ni.com/support you have access to everything from
troubleshooting and application development self-help resources to email
and phone assistance from NI Application Engineers.

National Instruments corporate headquarters is located at

11500 North Mopac Expressway, Austin, Texas, 78759-3504.

National Instruments also has offices located around the world to help
address your support needs. For telephone support in the United States,
create your service request at ni . com/support and follow the calling
instructions or dial 512 795 8248. For telephone support outside the United
States, contact your local branch office:

Australia 1800 300 800, Austria 43 0 662 45 79 90 0,
Belgium 32 0 2 757 00 20, Brazil 55 11 3262 3599,

Canada 800 433 3488, China 86 21 6555 7838,

Czech Republic 420 224 235 774, Denmark 45 45 76 26 00,
Finland 385 09 725 725 11, France 33 0 1 48 14 24 24,
Germany 49 0 89 741 31 30, India 91 80 41190000,

Israel 972 0 3 6393737, Ttaly 39 02 413091, Japan 81 3 5472 2970,
Korea 82 02 3451 3400, Lebanon 961 0 1 33 28 28,
Malaysia 1800 887710, Mexico 01 800 010 0793,
Netherlands 31 0 348 433 466, New Zealand 0800 553 322,
Norway 47 0 66 90 76 60, Poland 48 22 3390150,

Portugal 351 210 311 210, Russia 7 495 783 68 51,
Singapore 1800 226 5886, Slovenia 386 3 425 42 00,

South Africa 27 0 11 805 8197, Spain 34 91 640 0085,
Sweden 46 0 8 587 895 00, Switzerland 41 56 200 51 51,
Taiwan 886 02 2377 2222, Thailand 662 278 6777,

Turkey 90 212 279 3031, United Kingdom 44 0 1635 523545

National Instruments, NI, ni.com, and LabVIEW are trademarks of National Instruments Corporation.
Refer to the Terms of Use section on ni . com/legal for more information about National
Instruments trademarks. Other product and company names mentioned herein are trademarks or trade
names of their respective companies. For patents covering National Instruments products, refer to the
appropriate location: Help»Patents in your software, the patents . txt file on your CD, or
ni.com/patents.

© 2006 National Instruments Corporation. All rights reserved. 372020A-01 Dec06
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